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In this booklet you will find everything you need to know
to get you up and running with QuickBooks 2008/09,
whether you are a new or existing user. We strongly
recommend that you read this booklet carefully and
follow the steps outlined to ensure your installation
process is as smooth as possible.

If you are upgrading from an older version of QuickBooks,
pay special attention to the notes describing features
that have been changed or added to QuickBooks since
your last upgrade. You may need to perform additional
steps in the upgrade process, depending on how old your
current version is. The headings in each section provide
a guide to finding the instructions relevant to you.
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System Requirements

Recommended system configuration

+ At least 1.8 GHz Intel® Pentium IV (or equivalent)

+ 512 MB RAM for Microsoft® Windows® XP/2000
users

+ 1 GB RAM for Microsoft Windows Vista™ users
Minimum system configuration

* 500 MHZ Intel Pentium Il (or equivalent)

+ At least 256 MB of RAM for a single user and at least
512 MB of RAM for multiple, concurrent users

» For Windows Vista users: 1.2 GHz Intel Pentium Il (or
equivalent) and 1GB RAM

+ Windows 2000/XP/Vista operating system*
» 1 GB of disk space (additional space required for
company files)

+ Internet Explorer 6.0 or later required (IE 6.0 is
provided on the QuickBooks Installation CD. Requires
an additional 70 MB)

+ Microsoft® .NET Framework Common Language
Runtime 1.1 (provided on QuickBooks Installation CD.
Requires an additional 150 MB.)

» Requires 9 MB for QuickBooks Pro Timer
+ At least 256-colour SVGA video

» Optimised for 1024x768 pixel screen resolution.
Supports 800x600 with small fonts

+ 24X CD-ROM

« All online features and services require Internet
access with at least a 56 Kbps modem (ADSL or
Cable Modem recommended)

Integration/compatibility requirements

» Microsoft® Word and Excel integration requires
Microsoft Word and Excel 2000, 2002, 2003 or 2007

+ If you want to synchronise with contact management
software, you need Microsoft® Outlook® 2000, 2002,



or 2003. Contact synchronisation with Outlook
requires QuickBooks Contact Sync for Outlook (to
download this software, go to the File menu, click
Utilities, and then click Synchronise Contacts)

» Compatible with Reckon Retail Point of Sale
Professional 2008/09 and Reckon Retail Point of
Sale Lite 2008/09

» (QuickBooks Enterprise ONLY) Business Planner
functionality requires Adobe® Acrobat® Reader® 5.0
or later

Multi-user requirements

Multi-user mode is optimised for Microsoft Windows
2000 Server or Windows Server 2003 operating
systems, and for Windows 2000/XP Pro/Vista**.

Terminal Services are supported for QuickBooks Premier
and Enterprise.

*The 64-bit versions of Windows XP and Windows Vista
operating systems are not supported.

**Not all versions of Windows Vista are supported. Support
is provided for Windows Vista Business and Windows Vista
Ultimate only.
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New QuickBooks users

Before you install QuickBooks:

Take a few moments to read through all of these
installation instructions. Then:

+ Log on to your PC as an Administrator

+ Close all programs

+ Disconnect from the Internet

+ Disable your anti-virus software and firewall

After you have installed QuickBooks:

« Enable your anti-virus software and firewall
» Connect to the Internet
» Activate QuickBooks, as described on page 10

To install QuickBooks 2008/09:

1. Insert the QuickBooks 2008/09 CD into the CD-ROM
drive.

If the Installation Wizard does not start automatically,
click Start in the Windows taskbar, then click Run.
Type D:\autorun.exe (where D: is the CD-ROM
drive letter). Click OK.

2. Select your region, i.e., Australia, Asia or New
Zealand.

Click Begin.

4. Click Install to install the QuickBooks 2008/09
application.
or

Click Trial to install the QuickBooks 2008/09 trial
version.

Note: If you want to upgrade an existing QuickBooks
company file using the QuickBooks 2008/09 Trial
version, read the instructions for existing users in
this booklet and see page 12 to check your upgrade
path and edition compatibility.



10.
11.

12.

13.

14.
15.

16.

17.

Click Begin.

Read the Licence Agreement, click | accept the terms
in the licence agreement and then click Next.

Enter your QuickBooks License Number and then
click Next.

You will find your License Number (also known as
your IKC) on the cover of the QuickBooks CD-ROM or
in the letter you received with your CD-ROM.

Select the installation type you want to use and then
click Install. (For more information on this, refer to
the QuickBooks Startup Guide.)

If you don’t have Microsoft .NET Runtime installed
you will be prompted to install it. Click Next.

Click Next.
Select your installation folder and then click Next.

Select if you want to use Google Desktop in
QuickBooks and click Next.

Click Install.

Click Finish.

Depending on your PC configuration and your edition
of QuickBooks, you may be prompted to reboot your
PC to complete the QuickBooks installation. If you
receive a prompt, you should reboot your system
now.

Double-click the icon on your desktop to open
QuickBooks 2008/09.

Create a new company file, or browse the features of
QuickBooks 2008/09 using the sample company file.



Activate QuickBooks

After the installation process is complete, you should
activate your copy of QuickBooks. You need an Internet
connection in order to activate online. If you have not
already done so, establish a connection to the Internet
now.

To activate your copy of QuickBooks:

1. In QuickBooks, create a new company file, or open
the sample company file.

2. Go to the File menu, click Activate QuickBooks, then
follow the onscreen instructions.

For more information about activating QuickBooks, refer
to the in-product Help.

If you do not have an Internet connection, press Ctrl+3
on your keyboard (not numeric keypad), or press Ctrl+F12
to open the QuickBooks Activation window. You will be
prompted to call the Reckon Customer Service Centre

to activate QuickBooks over the phone. Refer to the
QuickBooks Startup Guide for the Reckon Customer
Service phone number.

Windows Terminal Services

QuickBooks Premier 2008/09 and Enterprise 2008/09
Multi-user versions run on Windows Terminal Services
with certain configurations. For more information, please
refer to FAQ ID #Q9789 on our Knowledge Browser at
www.quicken.com.au/Support/FAQs.aspx.
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Existing QuickBooks users

Check the upgrade path for your current
version of QuickBooks

You can only upgrade to QuickBooks 2008/09 from
QuickBooks 2007/08.

If you are using an earlier version of QuickBooks, you will
need to first upgrade to QuickBooks 2007/08, and then
upgrade to QuickBooks 2008/09.

Note that some very early versions of QuickBooks do not
upgrade directly to QuickBooks 2007/08. You must first
upgrade to an interim version of QuickBooks, and then
upgrade to QuickBooks 2007/08.

Determine your upgrade path

If you are currently using QuickBooks 2007/08, follow
the upgrade instructions starting on page 14.

If you are using an earlier version of QuickBooks, find
your current version in the following table, then check the
upgrade path. If there is a tick for your version, you can
upgrade to QuickBooks 2007/08 directly.

Otherwise, you must first upgrade to the interim version
specified (trial versions are used for this step), and then
upgrade to QuickBooks 2007/08. Turn to page 24 and
follow the upgrade instructions for your version.

Trial versions of previous releases of QuickBooks

are included on the QuickBooks 2008/09 Upgrade
Resources CD. If you do not have a copy of the Upgrade
Resources CD, contact Customer Service.

Note: This booklet does not contain instructions for
converting Quicken CashBook data to QuickBooks. Refer
to the conversion instructions that came with QuickBooks
2005/06. These instructions can be obtained from Reckon
Technical Support. If converting from CashBook, you can
only convert data entered in CashBook 2003 or 2004.

12



Upgrade path to
Your current version QuickBooks 2007/08

QuickBooks 2006/07 or N
QuickBooks Enterprise
2006/07

QuickBooks 2005/06 or N
QuickBooks Enterprise

2005/06

QuickBooks 2004 or N

QuickBooks Enterprise 4.0

QuickBooks 2003 or N

QuickBooks Enterprise 2.0

QuickBooks 2002 N

QuickBooks v8 via QuickBooks 2002
QuickBooks v7.4 via QuickBooks 2002

QuickBooks v7.3 and earlier | via QuickBooks v7.4 and then
QuickBooks 2002

Quicken CashBook 2004 via QuickBooks 2005/06
Quicken CashBook 2003 via QuickBooks 2005/06

QuickBooks can only be upgraded to a compatible
QuickBooks product. Check the following table for
compatible QuickBooks products for your current version.

To... QuickBooks | QuickBooks | QuickBooks | QuickBooks | QuickBooks | QuickBooks
EasyStart Accounting | Plus Pro Premier Enterprise

From...
QuickBooks
Eagystarts |V v v v v v
QuickBooks
Accounting v v v v v
QuickBooks
Lite v v v v
QuickBooks
Plus ‘/ ‘/ ‘/ \/
QuickBooks
Pro '\/ '\/ \/
QuickBooks
Premier ‘/ \/
QuickBooks VJ
Enterprise

*0Only QuickBooks EasyStart 2007/08 can be upgraded to QuickBooks
EasyStart 2008/09. You cannot upgrade to QuickBooks EasyStart
2007,/08 from earlier versions.
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Upgrading from QuickBooks
2007/08

The notes below are intended to provide a brief overview
of major changes to QuickBooks that are relevant to

the upgrade and installation process, and to highlight
potential upgrade issues you should be aware of.

For more detailed information about any topic, please
refer to the QuickBooks 2008/09 Startup Guide or the
QuickBooks 2008/09 Upgrade Guide, (both available on
the QuickBooks 2008/09 Installation CD).

For technical assistance, support contact details are
provided on the back cover of this guide.

Before you begin — changes in QuickBooks
you should note

Autorun and Networks

In QuickBooks 2008/09, the Autorun system works only
if you install from the CD. To start the installation from
any other location, such as a network server, go to the
directory where your copies of the QuickBooks 2008/09
files are located and run setup.exe.

Server only install

QuickBooks 2008/09 allows you to install a Database
Server with QuickBooks Pro, Premier, and Enterprise
editions. Although the Database Server uses the same
installation sequence and IKC code as QuickBooks
2008/09, it does not count as one of your licensed
installations. For example, with QuickBooks Premier
you can install QuickBooks on three computers (up to a
maximum of five, depending on the number of licences
you have purchased), and install the Database Server
without violating the End User Licence Agreement.

14



Installing QuickBooks 2008/09 on Windows Vista

To install QuickBooks 2008/09 in Windows Vista,

you must be the QuickBooks Administrator, or have
Administrator rights under the Windows Vista operating
system. Once installed, however, users need only to have
Power User rights in order to use QuickBooks.

Multi-user mode on Windows Vista

Please note that Multi-user mode is supported only on
Windows Vista Business and Windows Vista Ultimate
platforms.

Using QuickBooks 2007/08 after upgrading to
QuickBooks 2008/09

After QuickBooks 2008/09 is installed on a PC, you
cannot use a previously installed version of QuickBooks
2007/08, as the Navigators in QuickBooks 2007/08 will
produce an error. After installing QuickBooks 2008/09, if
you need to use QuickBooks 2007/08, you will need to
uninstall the 2007/08 software, then reinstall it.

Unregistered earlier versions of QuickBooks
become trial versions

Following installation of QuickBooks 2008/09, any
previously installed versions of QuickBooks software
which have not been activated will become trial versions.
If you plan to use the earlier software versions after
installing QuickBooks 2008/09, please ensure that

the software is activated before installing QuickBooks
2008/09.

Online Backup in QuickBooks 2008/09

For QuickBooks 2008/09, the integrated backup solution
found in earlier QuickBooks versions has been replaced
by the Reckon Tools Online Backup System.

Current subscribers to this service will be contacted and
provided with further information.
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Change in EasyStep Interview availability

In QuickBooks 2008/09, after the EasyStep Interview
has been completed, it cannot be accessed again. This
is different from earlier versions, in which the EasyStep
Interview was always accessible.

Audit Trail

During the upgrade process, the Audit Trail will be
automatically switched on, even if it was not switched

on in your QuickBooks 2007/08 data file. In QuickBooks
2008/09, with significant enhancements in performance
over earlier versions, the Audit Trail is always on.

This ensures that an accurate record of your data is
maintained.

Printing preferences

Any printing preferences you may have set up in
QuickBooks 2007/08 are cleared during the upgrade
process. You will need to set your printing preferences
after the company file has been upgraded.

Customised templates

If you had customised templates in QuickBooks
2007/08, after you upgrade to QuickBooks 2008/09 the
layout of the templates may have changed. Therefore,
after you upgrade you should check the layout of your
templates.

Memorised reports

Any memorised reports you may have set up in
QuickBooks 2007/08 or earlier will not be available
after upgrading to QuickBooks 2008/09, and cannot be
imported. New memorised reports can be created using
the default reports available in QuickBooks 2008/09.

Memorised transactions

Any memorised transactions you may have set up in
QuickBooks 2007/08 or earlier will not be available
after upgrading to QuickBooks 2008/09, and cannot be
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imported. New memorised transactions can be created in
QuickBooks 2008/09.

Stock items are called Inventory items

Stock items in QuickBooks 2007/08 are referred to as
Inventory items in QuickBooks 2008/09. For example,
Stock Assembly items in QuickBooks 2007/08 are
referred to as Inventory Assembly items in QuickBooks
2008/009.

Units of Measure

During the upgrade process, any Units of Measure

you may have set up in your company file will change.

In QuickBooks 2008/09, Units of Measure sets are
introduced. Therefore, if your items with Units of Measure
enabled have multiple Units of Measure assigned, the
program will determine the smallest unit, then use that
as the base unit for that item in QuickBooks 2008/09.

All other units will be linked to this base unit as related
units.

For additional information about Units of Measure, refer
to the QuickBooks 2008/09 Upgrade Guide.

Change in Payroll Setup

The Payroll Setup wizard is no longer part of the
EasyStep Interview.

Bonus payroll item is carried over in upgrade to
QuickBooks 2008/09

If you have set up a Bonus payroll item in QuickBooks
2007/08, after upgrading it retains the Addition payroll
item type. The item will function in the same way as it did
in the 2007/08 software, and will not take on the new
functionality offered by the specific Bonus payroll item
introduced in QuickBooks 2008/09.

Deduction payroll item (Default Rate and Limit)

In QuickBooks 2008/09, the limit per pay period option
is only available for Superannuation Payroll items. After
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you upgrade, you should check that any Deduction payroll
item that had been used for superannuation purposes,
(such as salary sacrifice), and which had a limit per

pay period, has been upgraded correctly. To check

this, go to the Payroll Iltem list and select the relevant
superannuation payroll item. Then click Next until the
Default Rate and Limit window appears. At the bottom

of this window, you will see a checkbox labeled This is

a pay period limit. If the corresponding checkbox in the
previous version was selected, then this checkbox should
also be selected.

Addition and Deduction payroll items (Annual Limit)

Both Addition and Deduction payroll items now have
an Annual Limit checkbox. Unlike the limit appearing
in the Deduction payroll item in previous versions, this
checkbox works on an annual rather than a pay period
basis.

Payroll Reports only option

The Payroll Reports only preference has been removed
from QuickBooks 2008/09. If this preference is set to
“on” when you upgrade from QuickBooks 2007/08, the
Full Payroll preference will be enabled automatically. If
you do not wish this to happen, change the preference to
No Payroll before upgrading in QuickBooks 2007 /08.

Note that data from Payroll Premier can only be imported
into QuickBooks 2008/09 if Full Payroll is enabled.

Changes to terms used for Payroll (Start Date and
Left Date)

In the QuickBooks 2008/09 payroll system, there have
been changes to some of the terminology. The Start Date
is now known as the Hire Date, and the Left Date is now
known as the Release Date. These dates are still found
in the employees’ profiles.

Multiple Tax Agencies

The Tax Agency (such as the Australian Taxation Office)
is no longer set in preferences. In QuickBooks 2008/09,
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you can have multiple tax agencies in one QuickBooks
data file. Tax agencies have become suppliers, included
in the Suppliers list.

Tax ltems and Tax Codes

QuickBooks 2008/09 introduces a new tax system
incorporating Tax Codes and Tax Items. During the
upgrade process, all existing Tax Codes in your
QuickBooks 2007/08 data file will be associated with
Tax Items, the Sales Tax Iltem and the Purchase Tax
Item. For a detailed explanation of the new tax system in
QuickBooks 2008/09, refer to the QuickBooks 2008/09
Upgrade Guide, available on the QuickBooks 2008/09
Installation CD.

Exporting Tax Codes

To export custom Tax Codes from QuickBooks 2008/09,
and import them into a new data file, you must also
export the Item list. Tax Codes are now linked to Tax
Iltems as a new feature of QuickBooks 2008/09. If the
Iltem list is not exported, Tax Items are not exported, and
the Tax Codes will not function in the new company file.

Prepare your company file for upgrade

Before you begin the upgrade process, we strongly
recommend that you complete the following steps to
protect your company file and ensure its accuracy.

1. Cancel Accountant’s Copy

If you have Accountant’s Copy switched on, you need
to cancel it before you proceed.

To cancel Accountant’s Copy:

» Go to the File menu, click Accountant’s Copy, then
click Cancel Accountant’s Changes.

The main title bar indicates whether the Accountant’s

Copy is switched on. Refer to the in-product Help for

more information about Accountant’s Copy.
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Back up your company file to your usual backup
media

Make sure you label your backup media correctly
and store it in a safe place in case you need it later.
Do not overwrite this backup copy. For additional
information about backing up your data, refer to the
QuickBooks 2008/09 Startup Guide.

Create and print a Trial Balance report for your
company

Print a Trial Balance report from your current version
of QuickBooks before you upgrade. (Your current
version will have specific instructions for doing

this). Set the printed Trial Balance report aside for
reference after you have upgraded your company file.

Complete the processing of any online banking (ABA)
files

You will need to complete the processing of all online
banking files before upgrading. Any unprocessed
online payments created in QuickBooks will no longer
be available after the upgrade. These unprocessed
payments may also cause problems when creating
ABA files in the new version.

Verify your company file in your current version of
QuickBooks

To verify data in recent versions of QuickBooks:
» Go to the File menu, click Utilities, then click Verify
Data.

For instructions on how to verify data in earlier
versions of QuickBooks, refer to the documentation
provided with the product.

Read Changes to QuickBooks you should note

Ensure that you have read Before you begin —
changes to QuickBooks you should note (see page
14).



7. Schedule your upgrade to minimise disruption to your
business

We recommend that you schedule your upgrade
carefully in order to minimise any disruption to your
business. The most appropriate times are often in
the evenings, weekends, or after tax time.

Upgrading your company file
To upgrade your company file:

1. Double-click the QuickBooks 2008/09 icon on your
desktop.

The No company open window opens.
Click Open or restore an existing company.
3. Browse to your company file, select it, then click OK.

Follow the onscreen instructions to back up the
current data file and upgrade it to QuickBooks
2008/009.

This process may take several minutes to complete,
especially if you have a large data file. Do not interrupt
the process, exit from QuickBooks 2008/09, or
shutdown your computer until the upgrade has been
completed.

If you experience problems during the upgrade of your
data file, please step through the upgrade procedures at
least one more time before contacting Technical Support.
Charges may apply for this service.

After you upgrade

After upgrading your company file to QuickBooks
2008/09, you need to check that the upgrade was
successful so that you can start using your company file
in the new version.
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1. Create and print a Trial Balance report for your

company file
To create a Trial Balance report:

» Go to the Reports menu, click Accountant, then
click Trial Balance.

Compare the printed Trial Balance against the Trial
Balance you created from your previous version.

Verify your company file
To verify your company file:
1. Close all open windows within QuickBooks.

2. Go to the File menu, click Utilities, then click Verify
Data.

3. Back up your company file to your usual backup

22

media

DO NOT OVERWRITE YOUR PREVIOUS BACKUP! You
may choose to back up your company file to a CD-
ROM or other storage media. Ensure that you label
each disk correctly and store them in a safe place
in case you need them later. Do not overwrite this
backup.

(For more information on backing up your data, see
your QuickBooks Startup Guide, which is available on
the QuickBooks 2008/09 Installation CD.)

Check your Tax Codes and Tax Iltems

Check that your Tax Codes have correctly had Tax
ltems associated with them. Refer to the QuickBooks
2008/09 Startup Guide, available on the QuickBooks
2008/09 Installation CD, for details about how Tax
Codes are modified by the upgrade process.



5.

Check your Units of Measure items

Check that any Units of Measure items you may
have been using have also been upgraded, with the
smallest unit of the item in QuickBooks 2007/08
defined as the base item in QuickBooks 2008/09.
See the QuickBooks 2008/09 Startup Guide,
available on the QuickBooks 2008/09 Installation
CD, for details about how Units of Measure are
modified by the upgrade process.

Activate QuickBooks

After the installation process is complete, you should
activate your copy of QuickBooks. You need an Internet
connection to activate online.

To activate your copy of QuickBooks:

1.

In QuickBooks, create a new company file, or open
the sample company file.

Go to the File menu, click Activate QuickBooks, then
follow the onscreen instructions.

For more information about activating QuickBooks, refer
to the in-product Help.

If you do not have an Internet connection, press Ctrl+3
on your keyboard (not numeric keypad), or press Ctrl+F12
to open the QuickBooks Activation window. You will be
prompted to call the Reckon Customer Service Centre

to activate QuickBooks over the phone. Refer to the
QuickBooks Startup Guide for the Reckon Customer
Service phone number.
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Upgrading to QuickBooks 2007/08
from earlier versions

Before you begin — changes in QuickBooks
you should note

Upgrading from QuickBooks Version 8 or
earlier

Changes to QuickBooks Tax Payable account
structure

Your GST and WET Tax Liability account will be
consolidated to the Tax Payable parent account as of
QuickBooks 2002. This is to improve the accuracy and
efficiency of tax reporting. Please note that this will
cause the Trial Balance report in QuickBooks 2007/08
to differ from the Trial Balance report in your previous
version. For more information about this, refer to FAQ ID#
Q494 on our Knowledge Browser at www.quicken.com.
au/Support/FAQs.aspx.

Before updating your company file, you must ensure that
all the sub-accounts of the Tax Payable account are either
GST- or WET-related. If you have any other sub-accounts
which are related to other items, such as PAYG, you need
to move them outside the Tax Payable account.

Reporting of deposits

If you entered deposits with tax in Version 8 or earlier
versions, these transactions were reported as negative
inputs. These will now be reported as positive outputs on
the Tax Detail report in QuickBooks. This will not affect
your Tax Payable control account.

Online banking transactions from Versions 7 and 8

If you used the online banking functionality in
QuickBooks Versions 7 or 8, you may have online banking
transactions that are marked as To Send in your company
file. You need to complete the processing of these
transactions before you upgrade your company file.
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From the Online Banking Centre, either send these
transactions to your bank, or remove them from the
Items to Send area.

To remove the transactions:

1. Highlight the transaction, then click Edit.
2. Clear the Online Bank Pmt checkbox.

3. Click OK.

Ensure that you have no unsent online transactions
or statements in the Online Banking Centre before
upgrading your company file.

Upgrading from QuickBooks 2002
Changes to Item Wholesale Price and Price Levels

The Wholesale Price field has been phased out since
QuickBooks 2002. We have replaced this feature with
price levels. You can assign default price levels to
specific customers so that the appropriate price levels
automatically fill on invoices and other sales forms,
saving time and reducing data entry errors. If you have
previously used the Wholesale Price field, we recommend
that you make a record of your wholesale prices to
assign to the new Price Level list.

Changes to templates

QuickBooks now offers greater flexibility and functionality
for customising your templates. You can add new fields
to templates and customise them to your requirements.
QuickBooks may not recognise some templates created
in older versions of QuickBooks Pro. For example
estimates, progress invoices or remittance advices.
QuickBooks uses the default set if it cannot find a
template after upgrading. We have provided some
templates to replace these defaults.

To view the new default templates:
1. Go to the List menu, click Templates, then click

Import.
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2. Browse to the template you require and click OK.
Company and legal information

You need to make a note of your company and legal
information exactly as it appears in QuickBooks 2002.
You will re-enter this information in QuickBooks 2007,/08

To view your company and legal information:

1. Go to the Company menu and click Company
Information.

2. Make a note of your company and legal information.
Upgrading from QuickBooks 2003 or
QuickBooks Enterprise 2.0

Employee titles

Employee title data (Mr, Mrs, Ms or Dr) that you recorded
in QuickBooks 2003 may need to be updated in the
employee record once you have upgraded your company
file. For each employee, open the employee record and
choose the appropriate title from the drop-down list.

Complete online banking (ABA) files

You need to complete all online banking files before
upgrading. Any unprocessed online payments created in
QuickBooks 2003 will no longer be available after the
upgrade.

To create online banking files:

1. Go to the Banking menu and click Online Banking
Centre.

2. Select the payees to include in the online banking
file.

Click Create ABA File.

4. Enter a name and save the file.
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Pay a Customer or Other Name using the Bank
(Online) method

QuickBooks 2007/08 does not allow payments to a
customer or other name using the Bank (Online) method.
You can only pay a customer or other name using the
Cheque-to-print or Cash/Cheque method.

Upgrading from QuickBooks 2004 or
QuickBooks Enterprise 4.0

Changes to reports

We have improved and renamed several reports within
QuickBooks. The Superannuation, Employee Super
Contribution and Super Contribution Paid reports have
been renamed Super Report by Fund, Super Report

by Employee and Employer SGA Contributions report,
respectively. The Leave Liability report has also been
customised.

Complete online banking (ABA files)

You will need to complete all online banking files before
upgrading. Any unprocessed online payments created in
QuickBooks 2004 will no longer be available after the
upgrade.

To create online banking files:

1. Go to the Banking menu and click Online Banking
Centre.

2. Select the payees to include in the online banking
file.

3. Click Create ABA File.
4. Enter a name and save the file.
Business Activity Statement configurations

QuickBooks 2007/08 retains your BAS configurations
after you have upgraded your company file. QuickBooks
will look for the BAS configurations from the last detected
version of QuickBooks installed. However, we recommend
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that you verify the BAS configurations following the
upgrade.

Industry-specific configurations

If you are installing an industry-specific edition for the
first time, or changing from an industry-specific edition,
your personal settings and feature set will change after
the upgrade. Your personal settings will now reflect the
features specific to the edition that you are installing.

Upgrading from QuickBooks 2005/06
Import Web Connect File

If you use the Import Web Connect File feature in
QuickBooks 2005/06 for a Westpac Bank account, after
you upgrade your company file to QuickBooks 2007/08
you will need to edit the Westpac Bank account by
changing the branch code. In the Branch Code field the
number will appear in the format XXX-XXX. Simply remove
the dash (-) so that the format is XXXXXX. Click OK. For
more information, please see FAQ ID# Q9268 on our
Knowledge Browser at www.quicken.com.au/Support/
FAQs.aspx.

Upgrading from QuickBooks 2006/07
Tax Code Exception report

If your company file originated in QuickBooks Version 5
or earlier, you may experience a small error in the Tax
Code Exception report after you upgrade to QuickBooks
2007/08. This is due to an upgrade issue that occurs
with General Journal entries created in early versions of
QuickBooks. If your company file is from a later version
of QuickBooks, or you do not use General Journal entries,
this error will not occur.

Commissions payroll item type

In the Payroll Item list, the Commissions payroll item type
is now displayed as Other. This enhanced payroll item
type can now be used for other purposes, such as time
in lieu payments, as well as for tracking commissions.
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To view the Payroll Item list:
» Go to the Lists menu and click Payroll Item List.

QuickBooks 2007/08, QuickBooks Customer
Manager 2006/07 and Windows Vista

QuickBooks Customer Manager 2006/07 runs under

the Windows Vista operating system and integrates with
QuickBooks 2007/08. However, in order to ensure that
all of the integration functionality between QuickBooks
2007/08 and Customer Manager 2006/07 works
without incident under Windows Vista, you need to
ensure that you are running Customer Manager 2006/07
as the Administrator. If you do not, you may experience
unexpected results when you attempt to integrate your
QuickBooks customer data with Customer Manager.

This requirement does not exist under Windows XPR
Windows XP users may continue to use the Customer
Manager software as per normal after upgrading to
QuickBooks 2007/08.

QuickBooks Customer Manager 2006/07 is not
compatible with QuickBooks 2008/09

Note that after you upgrade to QuickBooks 2008/09,
you can no longer use QuickBooks Customer Manager
2006/07. Due to substantial product changes

in QuickBooks 2008/09, these products are not
compatible.

Prepare your company file for upgrade

Before you begin the upgrade process, we strongly
recommend that you complete the following steps to
protect your company file and ensure its accuracy.

1. Cancel Accountant’s Copy

If you have Accountant’s Copy switched on, go to the
File menu, click Accountant’s Copy, then click Cancel
Accountant’s Changes. The main title bar indicates
whether the Accountant’s Copy is switched on. Refer
to the in-product Help for more information about
Accountant’s Copy.
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Back up your company file to your usual backup
Media

Make sure that you label your backup file correctly
and store it in a safe place in case you need it later.
Do not overwrite this backup. For information on
backing up, refer to the in-product Help.

Create and print a Trial Balance report for your
company

Print a Trial Balance report from your current version
of QuickBooks before you upgrade. (Your current
version will have specific instructions for doing

this). Put the printed Trial Balance report aside for
reference after you have upgraded your company file.

Complete any online banking (ABA) files

You will need to complete the processing of all online
banking files before upgrading. Any unprocessed
online payments created in QuickBooks will no longer
be available after the upgrade. These unprocessed
payments may also cause problems when creating
ABA files in the new version.

Verify your company file in your current version of
QuickBooks

To verify data in recent versions of QuickBooks:

» Go to the File menu, click Utilities, then click Verify
Data.

For instructions on how to verify in earlier versions of
QuickBooks, refer to the documentation provided with
the product.

Read Changes to QuickBooks you should note

Ensure that you have read Before you begin —
changes to QuickBooks you should note (see page
14).



7. Schedule your upgrade to minimise disruption to your
business

We recommend that you schedule your upgrade
carefully to minimise any disruption to your business.
The most appropriate times are often in the
evenings, weekends, or after tax time.

Upgrade your company file

Reminder: Before upgrading, have you:

» Printed a Trial Balance report from your original
QuickBooks program?

» Created a backup of your original company file and
verified it?

« Cancelled the Accountant’s Copy?

« Completed all online banking transactions?

To upgrade from QuickBooks Version 8 or earlier,
continue reading this page.

To upgrade from QuickBooks 2002, 2003, 2004,
2005/06 or 2006/07, go to page 33.

Upgrading from Version 8 or earlier

Reckon has sunsetted QuickBooks Versions 8 and
earlier. To convert your company file to QuickBooks
2007/08, you need to step your company file up through
more recent versions of QuickBooks (we use the trial
version of previous QuickBooks releases to do this). This
involves installing and upgrading to an interim version of
QuickBooks, then moving up to the next version.

The table below explains how to upgrade your company
file up to QuickBooks 2007/08 from each version.
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Current version |Upgrade path

v 7.3 orearlier |1. Install QuickBooks V7.4 Trial.

2. Install QuickBooks 2002 Trial
(version 9).

3. Install QuickBooks 2007/08.
4. Install QuickBooks 2008/09.

V7.4 to v8 1. Install QuickBooks 2002 Trial

(version 9).
2. Install QuickBooks 2007/08.
3. Install QuickBooks 2008/09.

These trial versions are all available on the QuickBooks
2008/09 Upgrade Resources CD.

Install QuickBooks V7.4 Trial
To install the QuickBooks V7.4 Trial:

1.
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Insert your QuickBooks 2008/09 Upgrade Resources
CD and exit from the installation window.

Click Start in the Windows taskbar, then click Run.

Type D:\Convert7\diskl\setup.exe (Where D:
is the CD-ROM drive letter). Click OK.

Click OK on any QuickBooks Trial messages that
appear.

Open QuickBooks 7.4 Trial and open your company
file.

Follow the onscreen instructions to upgrade your
company file.

Click OK to the warning about having in excess of
200 transactions.

Close the company file and QuickBooks.




Install QuickBooks 2002 Trial
To install the QuickBooks 2002 Trial:

1. Insert your QuickBooks 2008/09 Upgrade Resources
CD and exit from the installation window.

2. Click Start in the Windows taskbar, then click Run.

Type D:\Convert9\gbooks\setup.exe (where D:
is the CD-ROM drive letter). Click OK.

4. Click Yes to the Important Message for Upgraders
message about upgrading your company file.

5. Follow the onscreen instructions to complete the
installation.

6. Open QuickBooks 2002 (Version 9) Trial and open
your company file.

7. Follow the automatic instructions to upgrade your
company file.

8. Click OK to the warning about having in excess of
500 transactions.

9. Close the company file and QuickBooks.

Upgrading from QuickBooks 2002, 2003, 2004,
2005/06 or 2006/07

QuickBooks 2007/08 upgrades files from QuickBooks
2002, QuickBooks 2003, QuickBooks 2004, QuickBooks
2005/06 and QuickBooks 2006/07 directly.

Install QuickBooks 2007/08
Before you install QuickBooks 2007/08:

Take a few moments to read through all of the
installation instructions. Then:

» Log on to your PC as an Administrator

+ Close all programs

+ Disconnect from the Internet

» Disable your anti-virus software and firewall
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After you have installed QuickBooks:

+ Enable your anti-virus software and firewall

To install QuickBooks 2007/08:

1.

Insert the QuickBooks 2008/09 Upgrade Resources
CD into the CD-ROM drive.

If the installation does not start automatically, click
Start in the Windows taskbar, then click Run. Type
D:\Convertl6\QBooks\setup.exe (Where D: is
the CD-ROM drive letter). Click OK.

Enter your QuickBooks 2007/08 Installation Key
Code (IKC) when prompted and then click Next.

You will find your IKC on the QuickBooks 2008/09
Upgrade Resources CD (D: \Convertl16\Install
Key.txt).

Follow the onscreen instructions to install
QuickBooks 2007/08.

Reboot your PC to complete the QuickBooks
installation.

Upgrade your company file

Double-click the QuickBooks 2007/08 icon on your
desktop. QuickBooks 2007/08 automatically detects
your company file and opens the Update Utility. This
utility updates the format of your company file so that it
can be opened in QuickBooks 2007/08.

If QuickBooks does not detect your existing company file:

1.
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Click Open an existing company in the No company
open window.

Browse to your company file, select it, then click
Open.

Follow the onscreen instructions to back up the
current company file and upgrade it to QuickBooks
2007/08.



This process may take several minutes to complete,
especially if you have a large data file. Do not interrupt
the process, exit from QuickBooks 2007/08, or
shutdown your computer until the upgrade has been
completed.

If you experience problems during the upgrade of your
data file, please step through the upgrade procedures at
least one more time before contacting Technical Support.
Charges may apply for this service.

Note: If you receive error message C=44, refer to FAQ
ID#Q7410 on our Knowledge Browser at www.quicken.
com.au/Support/FAQs.aspx for instructions. This error
occurs as a result of corrupt transactions detected in
QuickBooks that need to be deleted and reentered.

After you upgrade

After upgrading your company file to QuickBooks
2007/08, you need to check that the upgrade was
successful so that you can continue upgrading to
QuickBooks 2008/09.

1. Create and print a Trial Balance report for your
company file
To create a Trial Balance report:
» Go to the Reports menu, click Accountant, then
click Trial Balance.

Compare the printed Trial Balance against the Trial
Balance you created from your previous version.

Note: If upgrading from QuickBooks Version 8 or
earlier, you will notice a change in your Trial
Balance report. For more information, see Tax
Payable Account Structure on page 24.
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2. \Verify your company file
To verify your company file:
1. Close all open windows within QuickBooks.

2. Go to the File menu, click Utilities, then click Verify
Data.

3. Back up your company file to your usual backup
media

DO NOT OVERWRITE YOUR PREVIOUS BACKUP! You
may choose to back up your company file to a CD-
ROM or other storage media. Ensure that you label
each disk correctly and store them in a safe place
in case you need them later. Do not overwrite this
backup.

(For more information on backing up your data, see
the QuickBooks in-product Help.)

4. Set preferences for State Payroll Tax

If you use the integrated payroll feature in
QuickBooks, you need to edit each Wage and
Addition payroll item to turn on the State Payroll Tax
option in the Taxes window.

To edit Wage and Addition Payroll Items:
1. Go to the Lists menu and click Payroll Item List.
2. Double-click a payroll item.
The Payroll Item wizard opens.

3. Select the State Payroll Tax option in the Taxes
window.

This change also applies to a Payroll Item list that
you import into QuickBooks 2007/08 as an IIF file.

You also need to edit each employee record that
should be included in State Payroll Tax report.

To edit employee records to include them in the State
Payroll Tax report:
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1. Go to the List menu and click Employee List.
2. Double-click the employee record you want to edit.

3. In the Edit Employee window, select the Payroll Info
tab, then click Tax Details.

4. Click the State tab and select the Include in State
Payroll Tax checkbox.

Next step: upgrade to QuickBooks
2008/09

To complete the upgrade process, go to page 14 and
follow the instructions to upgrade from QuickBooks
2007,/08 to QuickBooks 2008/09.
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QuickBooks 2008/09
End User Licence
Agreement



QuickBooks 2008/09 End User
Licence Agreement

THIS IS AN IMPORTANT DOCUMENT. PLEASE READ IT
CAREFULLY.

This is a contract between Reckon Limited (ACN 003 348 730)
(Reckon) and you. By using the QuickBooks® software supplied
with this document, and the related user guides and materials
(together the Software), you agree to be bound by the terms

of this Licence. This Licence covers copies of the Software
provided for evaluation or trial purposes, subscription versions
and non-subscription or full versions of the Software. Some
Licence provisions may not be applicable to you, depending on
the particular version of the Software you have purchased or if
you are using the Software for evaluation purposes. The defined
terms and the rules of interpretation in this Licence are set out
in clause 11.

Important: There are a number of technical features within the
Software that may affect your ability to continue to use the
Software. These are outlined in more detail in the terms of the
Licence, but in summary:

+ you are purchasing the right to use the Software, not to own
it;

 if you have been provided with a Trial Version, you may only
use the Software on a temporary basis to evaluate the
Software’s functionality and suitability for your requirements;

« the Software contains registration and activation processes
to guard against illegal copying;

+ to continue using the Software, those processes require you
to verify your compliance with the terms under which you
are licensed to use the software (for example: the number
of computers on which the software is installed) and to
permit continued reactivation of the Software from time to
time. This involves, in all versions, periodically verifying your
licence details, and in the subscription version, renewing
your subscription when it falls due. Reckon may also verify
subscription customers during a subscription period and
not only at renewal. You will also need to reactivate your
Software if you want to reinstall it (for example, if you
upgrade your computer or if you have a hard drive failure,
and you may incur a technical support cost for this);

« when you purchase the Software or during the course of
your subscription you will be provided with an installation
key code. Please keep the installation key code in a safe
place. You may need it when you first install or re-install



(if permitted) the Software and to reactivate the Software.
Please note if you lose your installation key code that it will
not be replaced by Reckon and you will not be able to install
or reactivate the Software;

you also need a licence key to reactivate your Software. In
addition, with some older versions of the Software, you will
not be able to re-install or reactivate the Software if you do
not have your installation key code - see details below on
Reckon’s sunset policy;

there will be no charge to activate the Software initially or

to reactivate your Software when you verify your licence
details or renew a subscription. Reckon may charge you a
fee for technical support if it needs to reissue a licence key
provided also that the version of the Software you are using
has not been ‘sunsetted’ as explained below. Reckon may
also charge a fee if you need to reactivate the Software in
other circumstances (for example, if you need to reinstall the
Software if you upgrade your computer or due to a hard drive
failure);

if you do not verify your licence details or renew your
subscription (as applicable) within the required period,

the Software may continue to operate but with impaired
functionality or you may not be able to access the Software
at all (including printing out or viewing any of your data or
records); and

Reckon has a ‘sunset policy’ which means that technical
support is not available for some older versions of the
Software. This includes the ability to install or re-install that
Software for any reason if you have lost your installation key
code for those old versions. If you wish to continue using the
Software in those circumstances, you will need to purchase a
new copy of the current version of that Software.

. LICENCE

(a) Evaluation licence: If Reckon has provided a Trial Version
of the Software to you, your rights to use the Trial Version
are solely as set out in clause 10.

(b) Licence to use: Reckon grants you a personal, non-
exclusive, non-transferable, limited licence to use the
Software on the terms of this Licence for the period
determined in accordance with clause 8.

(c) No transfer of copyright: The Software is licensed not
sold, despite any reference to “purchase” or “sale”
in this Licence or in any invoice or purchase order for
the supply of the Software. Reckon reserves all rights
not expressly granted to you. Intuit Inc. is the owner
of copyright in the Software and retains ownership of
the copyright and all other intellectual property rights
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in the Software and is protected by copyright law and
international copyright treaty.

2. YOUR PERMITTED USE OF THE SOFTWARE

(a)

(b)

(c)

(d)

Single use licence: If you have purchased a single user
licence, you:

(i) may install the Software once, on one computer
only. However, if you wish to reinstall the Software
(for example, if you need to install the Software on a
replacement computer), then clause 3 will apply; and

(i) must ensure that the Software is used by one person
only at any one time.

Additional licences: If:

(i) more than one person is to use the Software at the
same time; or

(i) the Software is to be installed on more than
one computer then you must, for example in the
Pro version, purchase another full version or a
subscription version of that software, for use by up to
a maximum of five users.

Premier Version

If you have purchased a full version of QuickBooks
Premier, this Licence entitles you to load the Software on
up to three computers (for use by a single processing unit
only on each computer) for use by up to three individuals
simultaneously. If you wish to install the Software

on more than three computers you must purchase
additional licenses that will permit up to five users to
simultaneously access a data file. If Reckon releases

the next release of QuickBooks Premier while you are a
member of the Advantage programme subject to its terms
and conditions, you will be permitted to make a total of
five installations.

If you have purchased a subscription version of
QuickBooks Premier, this licence entitles you to load the
Software on up to five computers (for use by a single
processing unit only on each computer) for use by up to
five individuals simultaneously. If you wish to install the
Software on more than five computers you must purchase
another full version or a subscription version of that
software but for simultaneous access you will need to
upgrade to an appropriate version that permits more than
five users to simultaneously access a data file.

Accountant Edition

If you are an eligible Professional Partner who has
purchased a full version of QuickBooks Accountant
Edition, this Licence entitles you to load the Software on



(e)

)

()

up to five computers (for use by a single processing unit
only on each computer) for use by up to five individuals
simultaneously. In some special cases with written
approval of Reckon only, certain Professional Partners
may be allowed to load the Software on up to 25
computers. However, only 5 simultaneous users can have
access to any single data file

Enterprise Version

(i) If you have purchased the QuickBooks Enterprise
version of the Software, this Licence entitles you to
load the Software on up to ten computers with the
option to load up to another 20 computers at the
applicable charge (for use by a single processing unit
only on each computer) for use by up to ten or more
individuals up to a maximum of 30 (as permitted by
the Licence purchased) simultaneously. You may not
load the Software onto any further computers.

(ii) If you have purchased the QuickBooks Enterprise
Accountants version of the Software, this Licence
entitles you to load the Software onto one computer
(for use by a single processing unit). You may not
load the Software onto any further computers.

General restrictions: You must not:

(i) use or rely upon the Software for any purpose or in
any manner for which the Software is not warranted;

(i) copy, reproduce, translate, adapt, vary, merge or
modify or create any derivative work based on the
Software;

reverse engineer, decompile, disassemble,
reconfigure or otherwise attempt to discover the
source code of the Software; or

sell, market, network, transfer, lease, license,
sub-license, rent, lend or otherwise dispose of or
distribute the Software or use the Software to provide
a bureau service.

(i

(iv

=

Licence verification: Upon written request from Reckon,
including by e-mail, you agree to provide Reckon with a
signed certificate:

(i) verifying that the Software is being used fully in
accordance with this Licence, including user and
machine limitations, and

(ii) listing locations, types and serial numbers of
equipment on which the Software is run.

You agree to allow Reckon to use and disclose any

personal details provided to Reckon in connection with
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(h)

this Licence in accordance with Reckon’s then current
privacy policy displayed on Reckon’s website.

Audit rights: Reckon may also audit the number of
copies of the Software in use or possession by you,

the equipment on which the Software is installed or
used and the number of users using the Software.
Audits will be conducted in your normal business hours,
or upon reasonable prior written notice, at Reckon’s
expense. If the audit reveals underpaid or unpaid fees
due to Reckon, Reckon may require you to uninstall any
unauthorised versions of the Software and may deny you
access to the Software or you will be invoiced for them
based on Reckon’s then current price list, and if these
exceed 5% of the license fees you have already paid, you
will also be invoiced for the cost of the audit.

3. PRODUCT ACTIVATION AND VERIFICATION

(a)

Initial registration and verifying licence details: This
Software may contain technology that protects Reckon
against illegal copying. As a consequence, you may be
required to:

(i) register your details during the initial installation
(including your name, contact details and details of
the hardware on which the Software will be installed
(if this is not done automatically by the Software);

(ii) if you have a full version, have the Software
reactivated periodically thereafter by verifying your
licence details to confirm you are using the Software
in accordance with these Licence terms;

if you have a subscription version, have the Software
reactivated (on payment of Reckon’s renewal fee
and verification of your licence details) if you wish to
renew the subscription;

(ii

(iv

=

have the Software reactivated by Reckon if you wish
to re-install the Software (for example, if you would
like to install the Software on a new computer or if
you have a hard drive failure and need to reload your
Software); and

(v) provide to Reckon the details of your installation key
code and product key for the Software as part of the
reactivation process.

You agree to activate or reactivate the Software within
a reasonable time or within such time as the Software
prompts you to do so.

Key codes: Each copy of the Software is provided with
a unique installation key code (which may appear on
the packaging or the cover of the media on which the



(d)

(e

®)

()

Software is contained). You should keep the installation
key code safe. As per clause 3(a)(v), you will be required
to provide your installation key code to Reckon when you
reactivate your Software.

Manner of verification: You must verify your licence details
in the manner required by Reckon from time to time
(which may include email or on-line registration via the
Internet). The Software may prompt you as to the required
manner of verification.

Charges for reactivation: Reckon will not charge you

to activate the Software initially or to reactivate your
Software when you verify your licence details or renew

a subscription, unless you have lost your installation or
licence key code. You need both your installation code
and your licence key to be able to reactivate the Software.
Reckon may charge you a fee for technical support to
reissue a licence key. Reckon may also charge a fee for
technical support if you need to reactivate the Software in
other circumstances (for example, if you need to reinstall
the Software because you have a new computer or need
to reload the Software due to a hard drive failure). For
the current fees go to http://www.quicken.com.au. If you
have lost your installation key code it will not be replaced
by Reckon and you will not be able to install or reactivate
the Software.

Consequences of non-renewal and failure to verify details:
This Software is provided to you on the understanding
and acknowledgment that it may contain technology
which deactivates and disables the Software if a
subscription is not renewed or in the case of a full
licence version, you have not verified your licence details
when periodically prompted to do so by Reckon or by the
Software. If the Software is not reactivated within the
required period, the Software may continue to operate
but with impaired functionality or you may not be able

to access the Software at all (including printing out or
viewing any of your data or records).

Statutory declaration: In certain circumstances, before
permitting a re-activation, Reckon may require you to
provide it with a Statutory Declaration stating the reasons
for re-activation in a form required by Reckon.

Older versions: Reckon has a sunset policy (covered in
more detail in clause 4(a)) which means that technical
support is not available for certain older versions of the
Software. If technical support is not available for your
version, you will not be able to reactivate or reinstall
your Software if you do not have your installation key
code. Reckon will not be obliged to provide you with a
replacement key code and in those circumstances you
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will need to purchase a new version or Upgrade in order
to continue using the Software. Please go to http://www.
quicken.com.au to see the sunset policy.

4. TECHNICAL SUPPORT

(a)

(b)

(c)

Period when technical support is available: Reckon will
provide technical support for the Software, during the
following periods:

(i) in the case of a subscription version of the Software,
during the period for which you have paid the relevant
subscription fees (unless further releases of the
Software in question are discontinued); and

(i) in the case of a full version of the Software, there is
a ‘sunset period’ during which technical support may
not be available for that version. The sunset period
for a version will commence on the earlier of:

(A) 2 years after the date on which you first installed
the version on your computer; or

(B) the date Reckon releases the second successive
Upgrade to that version.

For further explanation of Reckon’s sunset policy
please go to http://www.quicken.com.au.

What is included as part of technical support: Reckon will
provide technical support in accordance with its then
current technical support policy, which may include:

(i) as contemplated by clause 3, the technical support
required to reactivate the Software or to issue a
replacement registration key code (for example, when
you verify your licence details, renew a subscription or
if you need to reinstall the Software);

(i) provision of telephone help desk support services;

(iii) access to technical information about the software
contained on Reckon’s website; and

(iv) the ability for you to download Updates,

but it does not include provision of Upgrades of
the Software. For further explanation of Reckon’s
technical support policy please go to http://www.
quicken.com.au.

Fees: Clause 3(d) sets out the circumstances when you
will (and when you will not) be required to pay charges
for the technical support to reactivate your Software
(including when you wish to reinstall the Software) or for
Reckon to issue a replacement registration key code.

For all other technical support, Reckon may charge you a fee
in accordance with its then current technical support policy.
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5. ONLINE SERVICES

(a)

(b)

()

Interaction with Online Services: The Software may contain
access to, or features that interface with, online services
(“Online Services”). Examples of Online Services that
may be applicable to the Software are an online share
price download facility, a statement download facility, bill
and other payment services, a superannuation choice
facility, online backup facility, payroll services and a

debt recovery facility which are provided at an additional
charge on a subscription basis measured for one year
from the date of registration.

Terms for Online Services: Certain Online Services are not
available for all versions of the Software. For example,
in the case of bank statement download services, not
all banks provide services that connect to the Software.
Online Services are only available for 12-month periods
for subscription versions and 24-month periods for full
versions. In the case of a full version, access to Online
Services in the second 12-month period may be subject
to payment of the applicable charges. In order to renew
access to Online Services at the end of the 24-month
period in the case of a full version, you will be required
to have purchased or upgraded to the latest version of
the Software. In the case of a subscription version, you
must have renewed your subscription. Internet access
is required for all Online Services. Charges may apply
for the use of Online Services (in addition to the cost
of Internet access levied by your ISP). Where Online
Services are available, separate terms and conditions
with the provider of the Online Services may apply. In
some cases Reckon may be the provider. You should
check with the relevant third party provider as to the
terms and conditions of use. Access to Online Services
may be withdrawn by Reckon at any time. Reckon will
not be liable for the withdrawal of access to any Online
Services. Where access is to be withdrawn, Reckon
may choose to notify you in advance provided that you
have supplied Reckon with a valid and up to date email
address.

Other third party services and applications: In some cases
you may download other third party applications, for
example Google Desktop supplied by Google Inc. In such
cases your agreement to be bound by the terms of this
Licence will also bind you to the terms of use or other
similar agreements required by such third parties for use
of their products.
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6. LIMITED WARRANTY
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(a)

(b

(c)

(d)

(a)

(b)

(c)

Software provided on an ‘as is’ basis: Subject to clause
7(b), Reckon provides the Software to you on an “as
is” basis and without any representations by Reckon
or any of its authorised distributors regarding the use,
performance, or results of the use of the Software.

Defects in media: Reckon warrants that the media on
which the Software is recorded is free from defects in
manufacture for a period of 90 days from the date of
delivery. During this period, if you return the Software

to your place of purchase, Reckon will replace any
defective media on which the Software was supplied and
any Software on that media, free of charge, unless you
caused damage to the media due to poor handling.

No guarantee that Software will be error free or that its
use will be uninterrupted: While Reckon has endeavoured
to make sure that the Software works substantially as per
the specifications published by Reckon from time to time,
Reckon does not guarantee that the Software will work

on all computer hardware platforms or configurations and
makes no warranty that the Software will be error free,
that its use will be uninterrupted or that it will be fit for
your purpose.

Internet access, telecommunications networks, firewalls
and security: Reckon does not guarantee connections to
its online activation server as these may be dependent
upon third party networks and security measures over
which Reckon has no control.

. LIABILITY

Certain rights cannot be excluded: The Trade Practices
Act, 1974, and other laws may imply certain conditions
and warranties into this Licence and give you certain
rights and remedies that cannot be excluded or modified.
This clause 7, and the limited warranties provided in
clause 6, do not exclude or modify any of those rights if
to do so would contravene that law or make any part of
this Licence void.

Exclusion of warranties: To the full extent permitted by
law, Reckon excludes all conditions, warranties and rights
that may be implied into this Licence. If conditions,
warranties or other rights for your benefit are implied in
this Licence or otherwise conferred by law and it is not
lawful to exclude, restrict or modify them, then those
conditions, warranties and other rights will (but only to
the extent required by law) apply to this Licence.

Limitation of implied terms: Reckon’s (and its
distributors’) liability for breach of any implied conditions



(d)

(e)

")

or warranties that cannot be excluded is limited, to the
extent permitted by law and at the option of Reckon, to
replacing or re-supplying the goods or services or their
equivalent again or the payment of the cost of having the
goods or services or their equivalent replaced or supplied
again.

General exclusion and limitation: Other than as set out in
clauses 7(b) and 7(c), and to the full extent permitted by
law:

(i) Reckon (and its authorised distributors) will not be
liable to you or any other person for any direct or
indirect loss, damages, liability, costs or expenses
suffered by you or any other person relating to the
performance or non-performance of the Software
or any breach of this Licence or the supply of the
Software or in connection with, but not limited to,
the Online Services, use of tax tables or provision of
technical support (whether by telephone or remote
access or other means); and

(if) Reckon’s maximum liability for damages arising in
connection with this Licence or the supply of the
Software is limited to the amount paid by you for the
Software.

Your liability to Reckon: You agree that Reckon (and its
authorised distributors) will not be liable, other than

as expressly set out in this Licence, and that you will
indemnify Reckon (and its authorised distributors) from
any liability, loss, damage, costs or expenses which you
may suffer or incur as a result of your use of the Software
(including any claims made against you by third parties).

Use of Software is not provision of professional advice:
The information contained in this Software may include
features designed to assist you in complying with the
requirements of the relevant legislation, eg: imposing the
Goods and Services Tax (the ‘GST’) or the equivalent in
the user’'s home country. These features in the Software
have been developed with regard to the GST laws and
regulations and guidelines provided by the Australian
Taxation Office (the “GST Laws”) as at the date of
development of the Software (or the user’s home country
tax office) (the “GST Laws”). The GST Laws are subject
to change and the Software may not be correct at the
date upon which you make use of the Software. While
the features will assist in GST calculations, Reckon

does not warrant that the Australian Taxation Office or
the user’'s home country tax office will agree with such
calculations. The help contained in this Software is not
a substitute for professional advice. The GST, Tax and
other Laws are extremely complex in nature and legal
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(h)

(i)

and accounting advice should be obtained before taking
any action in reliance on this Software. The software is
also not financial product advice. If the Software contains
features to assist with superannuation guarantee
requirements, then Reckon does not warrant that the
relevant reports will be compliant with legal requirements,
as these change from time to time. In addition any tax
tables (which are included with certain versions of the
Software, eg: QuickBooks and Payroll) that might be
supplied with this Software are also changed from time

to time and you should consult with your professional
adviser before relying on the tax tables. Reckon does

not warrant that the tax tables are up to date at your

date of purchase. In providing you with the tax tables,
Reckon is not engaged in rendering legal, accounting or
other professional services. If legal advice or other expert
assistance is required, you should seek the service of a
competent professional.

Reckon has no responsibility for recommendations:
Reckon, its employees, agents, contractors and the
authors disclaim any and all liability and responsibility
to any person, whether a user of this Software or not,
in respect of anything (including, without limitation,
any error in or omission from this Software) and of the
consequences of any actions taken or omitted to be
taken in reliance, whether wholly or partially, upon all
or any part of the content, recommendations or help
contained in this Software.

Corruption of data and on-line access: To the full extent
permitted by law, Reckon and its authorised distributors
disclaim all liability for any corruption of data, inability to
access data, loss of data, breach of privacy, or downtime
as a result of or arising from the use of any online link
available between the Software and another server
including without limitation in connection with any Online
Services.

On-line services: Reckon makes no warranty or
representation in connection with the Online Services, the
responsibility for which rests with the relevant provider of
such Online Services.

8. TERM AND TERMINATION OF LICENCE
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(a)

Licence Term: Unless this Licence is terminated earlier in
accordance with its terms, your right to use the Software
in accordance with this Licence continues:

(i) in the case of a subscription version of the Software,
for an initial period of 12 months from the date
of registration of the Software. This Licence will
automatically renew for a further 12 month period



upon the payment of Reckon’s annual subscription
fee. If the annual subscription fee is not paid on

or before the termination of the current 12 month
period, this Licence will automatically terminate; and

(i) in the full version of the Software, indefinitely,
however:

(A) you may be required to periodically verify your
licence details and have the Software reactivated
as per clause 3 in order to keep using the
Software; and

(A) if you need to reinstall the Software, you will
need a copy of your original CD (or other media
on which the Software was provided) and the
installation key code. If you do not have the CD,
you will need to purchase or upgrade to a new full
version and pay for the postage associated with
sending the CD to you. Clauses 3(d) and 3(g)
outline when Reckon may charge you a fee for the
provision of a replacement key code and, more
importantly, when a replacement key code will not
be provided by Reckon due to the operation of
Reckon’s sunset policy.

(b) Termination by Reckon for breach: Reckon may terminate
this Licence if you are in breach of its terms or as
otherwise set out in this Licence.

(c) Survival: Clauses 2, 4, 6, 7 and this clause 8 will survive
the termination of this Licence. Termination of this
Licence will not prejudice any right which Reckon may
have, or but for the termination may have had, against
you for a breach of this Licence.

(d) Things you must do upon termination: Upon the
termination of this Licence, you or your representative
must promptly uninstall the Software from your computer,
destroy the CD, User Guide and related materials and any
copies of them in your possession or control or return
or dispose of them in the manner directed by Reckon.
Upon written request from Reckon you agree to provide a
Statutory Declaration to Reckon that you have complied
with your obligations under this clause 8(d).

9. SUBSCRIPTION TERMS

If you have purchased a subscription version of the Software,
this additional clause 9 will apply.

(a) Entitlement to Upgrades and Updates: During the period
for which you have paid subscription fees you will receive,
included in the cost of the subscription, all Upgrades
and/or Updates of the Software, via Internet download.
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(b)

(c)

(d)

(e)

()

()

(h)

No extension of Licence term: Your right and entitlement
to use the Software, as enhanced by any Upgrades and/
or Updates, concludes at the end of the term of the
Licence (subject to payment of an annual subscription
fee) and is not linked to the dates of release, registration
or provision by Reckon of any Upgrades and/or Updates.

This Licence prevails: If you have purchased this Software
as an Upgrade to an earlier version of the Software, this
Licence shall supersede any previous licence agreement.

Not all Upgrades included: Your subscription to the
Software and any Upgrades and/or Updates under this
Licence does not grant you the right to receive special
versions of the Software created for certain customers

or market segments, even though they may contain
similar features or functions. Versions of the Software
which may from time to time be offered in retail or other
channels in different configurations as special promotions
are not included as part of the subscription.

No obligation on Reckon to upgrade: Upgrades and/

or Updates will be developed and released by Reckon

in its sole discretion, and Reckon does not warrant or
represent that it will develop or release any Upgrades
and/or Updates during the term of the subscription
period or Licence. Furthermore, Reckon does not warrant
that the Upgrades and/or Updates will be provided to

you or made available within any specified time period
following the commercial release of such Upgrades and/
or Updates.

When payment is due: If applicable to the Software
licensed to you, you will be required to pay the monthly
subscription fee in advance on the first business day
of each month. You authorise Reckon to direct debit
your monthly subscription fee from the bank account
nominated by you.

Deactivation at end of subscription period: As per clause
3, the subscription version of the Software is provided
to you on the understanding and acknowledgment that it
may contain technology which deactivates and disables
the software if your subscription is not renewed or you
are found to be in breach of this license agreement If
the Software is not renewed by the end of the required
period, the Software may continue to operate but with
impaired functionality or you may not be able to access
the Software at all (including printing out or viewing any of
your data or records).

You need a full version if you don’t renew: If you elect
not to renew your subscription, the Software does not
allow you to upgrade to a non-subscription version of the
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Software by way of the purchase of an Upgrade pack.
In such circumstances, you are only able to upgrade
to a later non-subscription version of the Software by
purchasing a full (non-upgrade) version of the Software.

Early termination: If you wish to terminate your
subscription early, you must do so by giving Reckon

no less than one calendar month notice to that effect.
Depending on the type of software you have subscribed
to and the type of subscription you are signed up for, you
may be required to pay a cancellation fee. See http://
www.quicken.com.au for a schedule of fees. Reckon

will direct debit your account, and you agree to pay, the
applicable cancellation fee.

10. TRIAL LICENCE

If you have been provided with a Trial Version of the Software,
this clause 10 sets out the terms that will apply to your use of
the Trial Version.

(a) Licence: Your licence to use the Trial Version:

(b)

(c)

(i) permits you to evaluate the Software’s functionality
and suitability for your requirements;

(ii) is for the number of users set out in the material
accompanying your copy of the Trial Version;

(iii) is subject to the general restrictions in clause 2(e)
and the limited warranty in clause 6(a); and

(iv) is for up to 6 uses of the Software. Upon the sixth
attempt, you will be required to activate the Software
in order to begin the ninety-day Evaluation Period.

Duration: You acknowledge that your licence to use the
Trial Version will only apply for the Evaluation Period. At
the end of the Evaluation Period:

(i) you must not and will not be able to continue to
access the Trial Version, including any data that you
have entered into the Trial Version; and

(ii) if you wish to use the Software you must purchase a
full version or subscription version of the Software.

Entitlements: You:

(i) are not entitled to Upgrades or Updates (or any other
software other than the Trial Version); and

(if) may be required to pay for any technical support
that you may require in relation to the Trial Version in
accordance with Reckon’s then current charges.

Liability: You acknowledge that subject to clause 7(b)
and 7(c), and to the full extent permitted by law, Reckon
excludes all liability to you for any loss, damage, liability,
costs or expenses suffered by you relating to the
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performance or non-performance of the Trial Version or
any breach of this clause 10.

11. GENERAL
(a) Some defined terms: In this Licence:

®)

Trial Version means Software that has been provided to
you on a temporary basis in order to carry out a trial of
that Software to determine whether you wish to use the
Software on an ongoing basis.

Upgrade means a new version of the Software which
contains additional functionality or other enhancements.
Reckon will determine whether a new version constitutes
an Upgrade or an Update.

Update means a new version of the Software which
contains minor enhancements.

Applicable law: This Licence is governed by the laws of
the State of New South Wales, Australia.

Entire Agreement: This Licence contains the entire
agreement between Reckon and you in relation to its
subject matter and supersedes any prior agreements and
understandings, whether written or oral.

Waiver: Any failure to enforce any rights under this
Licence by Reckon is not to be taken as a waiver of those
rights.

Variation: To the extent permitted by law, Reckon may
vary any of the terms and conditions of this Licence
upon providing you with thirty (30) days notice in writing
and a copy of the replacement terms and conditions. In
the case of subscription users no new terms will come
into force until the commencement of your renewed
subscription period. Reckon will display any new terms
and conditions on Reckon’s web site and you should
check the QuickBooks website regularly (www.quicken.
com.au).

Headings: Clause headings are for ease of reference only
and do not affect the meaning of this Licence.

Quicken and QuickBooks are registered trademarks of Intuit Inc.

Reckon and QB' are trademarks of Reckon Limited.
Copyright © 1985 - 2009 Intuit Inc., 2008 - 2009 Reckon Ltd.
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Product updates available online

Reckon regularly posts product news, announcements,
and other information of interest to QuickBooks users on
our website, www.quicken.com.au.

From the website, you can download product-related files,
such as updated tax tables, software service packs and
product updates. To keep your software secure and up-to-
date, visit the website regularly.

You must be a current Advantage or Subscription
customer, using the latest version of the software

in order to access these files. This also applies to
replacement updates if they are lost, for example by a
hardware failure. To avoid potential problems, be sure to
keep your Annual Membership up to date.

Store QuickBooks products safely

Your unique Installation Key Code and QuickBooks
2008/09 CD are extremely valuable and may be required
to reactivate or reinstall the software. Please keep your
code in a safe place with your QuickBooks 2008/09

CD. If you lose your Installation Key Code or CD, they

will be replaced only while this version is supported and
adminstrative charges may apply.
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Your important reference numbers

Customer ID:

Customer PIN:

Installation Key Code:

Installation

Computer/
User

Product Key

Licence Key

Example

Reception

10030-59821-
00858-381

36934-42890-
33878-21990

PC 1

PC 2

PC 3

PC 4

PC 5

You will need these numbers for re-registration purposes.
Please have these details on hand when contacting

Reckon.

To find these details in QuickBooks, go to the Help menu
and click My Licence Information.

My original CD is safely stored here:
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Contacting Reckon
Technical Support

Australia

For installation and software support, Technical Support
is available Monday to Friday, 9.00am — 5.00pm AEST.
Weekend support is also available, check website for
opening hours. Extended hours are available to Reckon
Advantage members.

e 1902 223 101 (Advantage members, please refer
to your Welcome Pack for Advantage technical support
contact details)

Call costs $4.90/min (incl GST) Charges are
higher from public and mobile phones. Call
costs and operating hours are subject to
change.

www.quicken.com.au/support

New Zealand
Technical support is available Monday to Friday,
9.00am — 5.00pm NZ.
Per incident support 0800 933 666
$35.00 plus GST

Per minute support 0900 33 609

Call cost — $3.95 /min (incl GST)

Charges are higher from public and mobile
phones. Call costs and operating hours are
subject to change.

www.quicken.co.nz

Asia
Technical support is available Monday to Friday, from
9.00am - 5.00pm at US$40 per incident support.

e Singapore +65 6254 2322

www.quicken-asia.com
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